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What’s New in Microsoft Office 2013? 
 
This course covers 8 hours of the very best and most essential Excel 2013 functionality that CPAs 
should be using in the performance of their jobs. This course is best suited for moderate level 
Excel users who know how to use the basic functionality of Excel, but have seldom explored the 
more powerful features and capabilities that Excel has to offer, including the following new 
features found in Excel 2013.  
 

New in Excel 2013 
 
1. Quick Tour of Menus – Almost identical to Excel 2010 
2. Touch-Screen Enabled – Makes Excel accessible on touch-screen mobile devices. 
3. Windows 8 Style Tiles – Match Windows 8 tiles, easier to touch on a smaller mobile device. 
4. Cloud-Enabled – Save Excel workbooks directly to your free cloud data storage SkyDrive. 

a. SkyDrive (20 to 25 GBs) 
b. Get A Link – Send Excel workbooks links instead of workbooks via email. 
c. Publish Excel Data to Social Media – Embed Workbooks directly in Facebook. 

5. Office 2013 Web Apps – a free version of Excel 2013 is available via the cloud. 
6. Subscription Pricing – Enables you to install Excel on five devices, and run Excel from the cloud. 

a) Installs on more PCs  
b) Never upgrade again 
c) Superior iMap email  
d) Better security  
e) File Sharing  
f) Eliminate upfront capital costs  
g) Eliminate balance sheet liabilities 

7. Excel Instances - Excel now opens each workbook in a separate instance.  
8. Flash Fill - Watches you work and applies logic to help you complete your tasks.  
9. Timeline Slicer - Helps you slice and dice Pivot data containing dates. 
10. Recommended Pivot Tables & Charts – To help you work quicker and easier. 
11. Quick Analysis - Helps you analyze data more quickly by offering data layouts. 
12. PowerView - Enables you to create new report types, such as the interactive map charts. 
13. Create Relationships Tool – Enables you to build PivotTables from multiple data sources.  
14. More Tables – Add multiple tables to a PivotTable 
15. Drill Up and Cross Drill - Drill upward and cross drill to related tables. 
16. New PivotTable Tools - Decouple PivotCharts so they stand alone. 
17. New Chart Controls - Excel pops up new chart controls.  
18. Review Tools - New inquire Add-in reviews design, function and data dependencies. 
19. Excel Compare Tool - Similar to Word’s Compare tool. 
20. Fifty New Functions – Bring the total number of functions to 455. 
21. Office on Demand - https://office.microsoft.com/en-us/myoffice.aspx?CTT=97  
22. Managing Updates – From the File, Account menu, you can set how updates install. 

 
These concepts are described in greater depth below. 
  

https://office.microsoft.com/en-us/myoffice.aspx?CTT=97
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1. No Changes to the 2013 Ribbons - Many CPAs worry that Office’s new touch-screen functionality 

means the product’s new ribbons that will be time-consuming to learn, but this is not the case. 

Office 2013’s ribbons work and look almost exactly like Office 2010’s ribbons, and transitioning to 

the new product involves only a minor learning curve. While the new touch-screen controls 

provide new ways to launch and use the applications on touch-screen devices, the 2010-style 

ribbon along with a standard keyboard and mouse remains to be the primary means for operating 

the product.  

 

2. Touch-Enabled - On mobile devices, the ribbons offer the same menu options, but they are 

redesigned to better fit smaller hand-held devices. Most of Office’s new touch controls work 

similar to mouse-clicks, but new gestures have been added. For example, you can navigate Excel 

workbooks or multiple pages in Word by swiping your finger across the screen. You can also pinch 

and spread to shrink or enlarge your spreadsheets, documents or presentations. A new Touch 

Mode button inserts more space around the Ribbon’s icons so operating the touch controls on 

smaller devices is a little easier.  

 

 
3. Windows 8 Style Tiles - Office’s new square, color-coded tiles (see figure) are used to launch 

applications on your tablet, smartphone, or computers equipped with touch-screen monitors. The 

tiles can be resized and rearranged to your preference, and the color-coded schemes make it 

easier to identify and select the correct application. Office’s tiles match the Windows 8 tiles which 

have been praised by some for their simplicity and utility. 

 

New Global Features in Office 2013 
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Examples of Office 2013 Quick Launch Tiles in Windows 8 

 
4. Quick Demonstration of Excel 2013 on a Touchscreen Mobile Device-  

 

5. Cloud Enabled - Office binds you to the cloud in many ways. For example, Office automatically 

connects to your free cloud-based SkyDrive which includes 20 GBs of data storage space, email 

account, contact management, calendar management, and the following free web apps: 2013 

editions of Word, Excel, PowerPoint, and OneNote. These web apps are cloud-based versions of 

the popular applications (with limited commands and features), accessible from any web browser 

on a desktop, laptop, tablet or smartphone device.  

 

 

Office 2013's Free Web Apps 

 
a) See SkyDrive on the smartphone. 

b) See example of opening the same Excel file from SkyDrive on Desktop computer. 

c) File, Info – Pick the sheets that browsers can see when opening that file. 
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d) Save a file to SkyDrive, show options to invite people, get a link, Post to Facebook or 

email. 

 
6. Web Apps - Since everyone has access to the free web apps, troublesome file-sharing barriers and 

file compatibility issues are removed; therefore, CPAs can use Office 2013 with the confidence of 

knowing that documents and workbooks they produce can be easily viewed and edited by others.  

 
7. Subscription Rental Plan - Microsoft offers Office via a subscription plan and many CPAs are 

finding the rental plan to be a better option than purchasing the product. Pricing options and 

functionality for selected Office 2013 editions are summarized in the table below. 

 
 

Office Edition 
 

Users/PCs Price Included 

 

Purchase Options: 

Office Home & Business 1 user/3 PCs $279.99 Word, Excel, PowerPoint, OneNote, 

Outlook 

Office Professional 1 user/2 PCs $499.99 Word, Excel, PowerPoint, OneNote, 

Outlook, Access, Publisher 

 

Subscription Options: 

Office 365 Professional Plus 1 user/5 PCs $15/Month Word, Excel, PowerPoint, OneNote, 

Outlook, Access, Publisher 

Office 365 E3 Plan 1 user/5 PCs $20/Month Word, Excel, PowerPoint, OneNote, 

Outlook, Access, Publisher, Cloud-

based email, Web conferencing, 

Shared calendars, Cloud-based team 

sites, Office Web Apps 

Pricing Options for Selected Editions of Office 2013 

 

Seven advantages for renting rather than purchasing are as follows: 
 

1. Installs on more PCs - The subscription plan allows you to install Office professional 
on five computers or devices, compared to just two or three installations with the 
purchased product.  
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2. Never upgrade again – Renters will never face an upgrade decision again as future 
product enhancements are included automatically.  

 

3. Superior iMap email - The subscription plan includes a cloud-based email solution 
using iMap (Internet Message Access Protocol), which is stronger than the traditional 
Pop3 (Post Office Protocol) email solution. This is because iMap maintains email 
messages, replies, contacts, tasks and calendars in a central location so you can access 
them from any of your computers, the web, or mobile devices. In contrast, Pop3 
maintains this information on the individual computers, thus accessing this 
information from multiple computers or devices is more problematic. 

 

4. Better security - In the cloud, data is securely encrypted from your computer to the 
cloud, and your data remains encrypted in the cloud. Your data is also backed up 
automatically on a continuous basis and is protected by world-class firewalls, anti-
virus software, and intrusion monitoring solutions. A significant amount of 
technology, cost and effort is needed to duplicate this level of security on a local 
computer or file server. 

 

Exception – Warning!!! 

 Microsoft’s agreement allows them to read your files!!! 
 
Here’s the code of conduct agreement:  
http://windows.microsoft.com/en-us/windows-live/code-of-conduct 
 
Here’s an example article in Forbes:  
http://www.forbes.com/sites/kellyclay/2012/07/19/is-microsoft-spying-on-skydrive-users/  

 
5. File Sharing – The subscription plan includes a cloud-based SkyDrive (starting at 20 

GBs), team management tools, and file syncing options to help groups work in 
collaboration. You can grant permission to others to access your SkyDrive files or 
folders, even if they don’t use Office. In the cloud environment, email attachments 
are unnecessary because you can send recipients a link instead of attachments; as a 
result, emails travel faster, deliveries are no longer hung up due to attached file size 
restrictions, and attachments no longer contribute to oversized inbox data files.  
 

6. Eliminate upfront capital costs – For larger companies, the subscription plan 
eliminates their need to borrow money to purchase product. By opting for the “pay 

http://windows.microsoft.com/en-us/windows-live/code-of-conduct
http://www.forbes.com/sites/kellyclay/2012/07/19/is-microsoft-spying-on-skydrive-users/
http://www.google.com/url?sa=i&rct=j&q=&esrc=s&frm=1&source=images&cd=&cad=rja&docid=sr8Pjb7YltuUMM&tbnid=FxQyugjfYEBMMM:&ved=0CAUQjRw&url=http%3A%2F%2Fwww.youtube.com%2Fwatch%3Fv%3DRG0ochx16Dg&ei=Q_erUdTANI-O9AT3v4CwCw&bvm=bv.47244034,d.eWU&psig=AFQjCNHDS-ln9W7ZUyIvbSAUIu8UoQanHg&ust=1370310815478430
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as go” subscription plan, companies can expense the costs as a monthly operating 
expense;  

 

7. Eliminate balance sheet liabilities – For larger companies, FASB 47 requires disclosure 
of long term obligations, but because Office’s subscription plan requires no long-term 
commitment, these rental obligations need not be included on the balance sheet. 

 
 

 
 
8. Excel Now Opens Each Workbook in a Separate Instance - Prior to Excel 2013, Excel opened multiple 

workbooks in the same instance of Excel by default. However, it was possible to launch Excel twice, 

and open workbooks in separate instances – but this approach had a problem in that Excel’s Paste 

function behaves differently when pasting between two instances of Excel compared to pasting 

between two workbooks opened in the same instance of Excel. Specifically, Excel 2010 and prior 

editions did not allow you to copy formulas back and forth between Excel files opened in separate 

instances – only the formula’s calculated value was pasted to the other instance of Excel.  

Excel 2013 now solves this problem allowing you to copy and paste formulas between 
separate instances of Excel. (FYI - Word has always opened Doc files in separate instances). 
 
This issue came to light once CPAs started using dual monitors, and they launched excel on 
each monitor only to find they could not copy and paste formulas back and forth. In case you 
have clients or colleagues that still use an older edition of Excel, here are the procedures that 
you had to follow to display two workbooks simultaneously on dual monitors, and preserve 
the ability to copy and paste formulas:  

  
1. Open only one instance of Excel. 
2. Restore down the Excel window by double-clicking the Title Bar located at the 

top of the window.  
3. Stretch the window across both monitors by hovering your mouse pointer over 

either the left or right edge of the window until your pointer becomes a double 
arrow, then click and drag the window across both monitors.  

4. Open two Excel workbooks. 
5. In Excel 2007 and 2010, select Arrange All from the View tab to display the two 

workbooks side-by-side, each appearing in a separate monitor. In Excel 2003, 
select Arrange from the Window menu, select Tiled, and click OK. 

6. You can now use Paste Special, Value, Add between the two Excel workbooks 
displayed on separate monitors.  
 
Note: To avoid undesirable results when stretching a window across two 
monitors, make sure both monitors are set to the same display resolution. 

New Features in Excel 2013 
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9. Flash Fill - Of all the Office 2013 applications, Excel is the beneficiary of the most impressive 

enhancements. Excel’s new Flash Fill watches you work and applies logic to help you complete your 

tasks. The example pictured below (see figure below) contains a list of 44 first and last names in 

Column A, which I want to separate into Columns B and C. As I start typing the first name of the second 

record in Column B; Excel’s Flash Fill guesses what I’m trying to do and offers to fill in the remaining 

42 first names (as shown in grey text). 

  

 

Excel's New Flash Fill Tool 

 
10. Timeline Slicer - Excel’s new Timeline Slicer which helps users slice and dice Pivot data that contain 

dates. As an example, selecting the dates May through October on the Timeline slicer (pictured) 

adjusts the PivotTable to display May thru October data.  

 

 

Excel's New Timeline Slicer provides a  

Visual Method of Filtering a PivotTable by Date 
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Recommended PivotTables and PivotCharts - Excel offers new tools which can analyze your data 
and recommend a variety of PivotTable and Chart layouts to best illustrate the data. This new 
functionality is especially useful to novice users who are less familiar with Excel’s functionality, 
but can also help avid Excel users save time too. Simply place the cursor anywhere in your data 
area and select Recommended PivotTables (or Recommended Charts) and in return, Excel offers 
various PivotTable and Chart options and as pictured in the figure. 

 

 

Excel's New Recommend PivotTables and Recommend Charts Tools 

 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, charts, 
totals, tables and sparkline layouts to instantly summarize large volumes of data (see figure 
below). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
 

 
Example of Excel's New Quick Analysis Tool 

 
Simply place your cursor in your data area and then press Ctrl + A to highlight your data. Then 
in the bottom right corner make your selections. 
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PowerView - Excel’s new PowerView inserts new worksheets connected to your data, and then 
enables you to create new report types, such as the interactive map chart presented in the figure 
below. The resulting PowerView Map report is zoomable, and filters can be applied to display 
partial data. 

 

 

PowerView Tool Depicting a New Zoomable Map View 

 
A few points about PowerView: 
 

1. PowerView is not included in Office 2013 Professional subscription, it is available in the Office 
2013 Professional purchased product and the Office 2013 Professional Plus Subscription. 

 
2. You can try PowerView for free here, as prepared in Excel 2013 and published to SharePoint: 

http://www.microsoft.com/en-us/bi/GetMicrosoftBI/TryIt.aspx   

 
3. For demonstration purposes, I will select the Contoso Tab, Contoso Sample Data 

 
4. PowerView produces a dashboard containing multiple PowerViews, each with it’s own unique 

view and capabilities.  
 

5. For example, the Scatter Chart includes a Play button, so you can view data over time. 

http://www.microsoft.com/en-us/bi/GetMicrosoftBI/TryIt.aspx
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6. By default, all PowerView reports are linked so one filter applies to all reports. Or if you prefer, 
click the Filter button in the upper right corner (as you hover a chart) to gain more control over 
filtering using the View tab versus Chart tab. 
 

7. An Advanced Filter Button, enables you to apply more advanced filters, such as “only those 
transactions greater than $1,000”. 
 

8. PowerView worksheets can be published as standalone, interactive reports to Microsoft 
SharePoint’s PowerPivot Gallery or other reporting service destinations.  
 

9. You can apply themes and backgrounds, insert pictures and text boxes, insert collapsible and 
expandable tiles, and add data slicers.  
 

10. I’ll give you a quick demonstration using Excel 2013. 
 

a. Invoices 
b. Quick PowerView Map 
c. Quick PowerView Scatter Chart 
d. Play the PowerView Scatter Chart 

 
Create Relationships - As an advanced enhancement, Excel provides the new Create 
Relationships tool for building table relationships in workbooks that contain at least two tables 
sharing at least one common field name.  
 
Before you start, you first need to convert your data to Tables, using the Insert Tables tool. Then, 
with a PowerView selected, click the Create Relationships tool and fill out the resulting dialog 
box pictured below. 

  

 

Excel's New Relationship Tool for Pivoting Multiple Sources of Data 

 
Once relationships are established, the More Tables option can be used to display additional 
tables allowing you to add data fields from mutiple tables to PivotTables, as pictured. 
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Connecting Multiple Sources of Data to a PivotTable 

 

Drill Up and Cross Drill - Another PivotTable enhancement involves drillability. Previously, users 
could only drill down on PivotTable data, but now you can also Drill Up and Cross Drill to related 
tables.  
 
50 New Functions - Microsoft has added 50 new functions to Excel (increasing the total number 
of functions to 450), and the following 12 new functions in particular will appeal to many CPAs. 

 

1. ARABIC – Converts roman numerals to regular numbers, for example V, IX, and XX are converted 
to 5, 9, and 20. 

 

2. CEILING.MATH – This function can be used to round a number up to a specific interval, such as 
the nearest 99 cents, as demonstrated in figure 10. 

 

 
Example Use of Excel's New Ceiling.Math Function 

 

3. DAYS – Calculates the number of days between two dates. 

 
4. FLOOR.MATH - Rounds numbers down to a specific interval, and also can be used to round 

negative numbers towards zero, instead of towards a smaller number. For example, -8.5 can be 
rounded to -8.0 (instead of the -9.0 results delivered by the older Round function).  
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5. FORMULATEXT – Displays referenced formulas as text, and can be used to improve formula 

reading, reviewing and printing. 

 
6. ISFORMULA – Returns the value TRUE if the referenced cell contains a formula. 

 
7. ISOWEEKNUM – Calculates the week during the year in which a given date falls. As an example, I 

used this formula to determine that I was born in the 53rd week of 1959. 

 
8. PDURATION - Returns the number of periods required by an investment to reach a specified 

value. For example, you could calculate that $1,000 invested at 6% APR would take 26.89 years to 
reach a value of $5,000. (This function approach is faster than constructing a 322 row table to 
figure this out.) 

 
9. RRI – This function returns an equivalent interest rate for the growth of an investment. For 

example, you could calculate that a $1,200 mutual investment that grew to $5,600 in 18 years 
earned an average return of 8.93%. 

 
10. SHEET – Calculates the sheet number of the referenced sheet. For example, you might use this 

function to determine that your interest rate assumptions are entered on the 46th sheet in your 
workbook. 

 
11. SHEETS – Calculates the total number of sheets in a referenced range.  

 
12. SKEW.P – Like the Skew function, SKEW.P calculates the standard deviation of a string of data, 

but bases its calculation on the entire population instead of a sample of the population. This 
function could be used to determine whether each line item of a company’s historical financial 
statement data is consistent enough to use as a basis for projecting the following year’s budget.  
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Fifty New Functions in Excel 2013 

  

FUNCTION NAME TYPE AND DESCRIPTION 

1. ACOT function Math and trigonometry:    Returns the arccotangent of a 

number 

2. ACOTH function Math and trigonometry:    Returns the hyperbolic arccotangent 

of a number 

3. ARABIC function Math and trigonometry:    Converts a Roman number to Arabic, 

as a number 

4. BASE function Math and trigonometry:    Converts a number into a text 

representation with the given radix (base) 

5. BINOM.DIST.RANGE 

function 

Statistical:    Returns the probability of a trial result using a 

binomial distribution 

6. BITAND function Engineering:    Returns a 'Bitwise And' of two numbers 

7. BITLSHIFT function Engineering:    Returns a value number shifted left by 

shift_amount bits 

8. BITOR function Engineering:    Returns a bitwise OR of 2 numbers 

9. BITRSHIFT function Engineering:    Returns a value number shifted right by 

shift_amount bits 

10. BITXOR function Engineering:    Returns a bitwise 'Exclusive Or' of two numbers 

11. CEILING.MATH 

function 

Math and trigonometry:    Rounds a number up, to the nearest 

integer or to the nearest multiple of significance 

12. COMBINA function Math and trigonometry:     

Returns the number of combinations with repetitions for a given 

number of items 

13. COT function Math and trigonometry:    Returns the hyperbolic cosine of a 

number 

14. COTH function Math and trigonometry:    Returns the cotangent of an angle 

15. CSC function Math and trigonometry:    Returns the cosecant of an angle 

16. CSCH function Math and trigonometry:    Returns the hyperbolic cosecant of 

an angle 

http://office.microsoft.com/client/15/help/preview?AssetId=HA102753256&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753257&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753258&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753259&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753250&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753250&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753251&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753252&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753253&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753254&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753255&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753249&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753249&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753248&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753260&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753261&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753262&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753263&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
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17. DAYS function Date and time:    Returns the number of days between two dates 

18. DECIMAL function Math and trigonometry:    Converts a text representation of a 

number in a given base into a decimal number 

19. ENCODEURL function Web:    Returns a URL-encoded string 

20. FILTERXML function Web:    Returns specific data from the XML content by using the 

specified XPath 

21. FLOOR.MATH function Math and trigonometry:    Rounds a number down, to the 

nearest integer or to the nearest multiple of significance 

22. FORMULATEXT 

function 

Lookup and reference:    Returns the formula at the given 

reference as text 

23. GAMMA function Statistical:    Returns the Gamma function value 

24. GAUSS function Statistical:    Returns 0.5 less than the standard normal 

cumulative distribution 

25. IFNA function Logical:    Returns the value you specify if the expression resolves 

to #N/A, otherwise returns the result of the expression 

26. IMCOSH function Engineering:    Returns the hyperbolic cosine of a complex 

number 

27. IMCOT function Engineering:    Returns the cotangent of a complex number 

28. IMCSC function Engineering:    Returns the cosecant of a complex number 

29. IMCSCH function Engineering:    Returns the hyperbolic cosecant of a complex 

number 

30. IMSEC function Engineering:    Returns the secant of a complex number 

31. IMSECH function Engineering:    Returns the hyperbolic secant of a complex 

number 

32. IMSINH function Engineering:    Returns the hyperbolic sine of a complex number 

33. IMTAN function Engineering:    Returns the tangent of a complex number 

34. ISFORMULA function Information:    Returns TRUE if there is a reference to a cell that 

contains a formula 

http://office.microsoft.com/client/15/help/preview?AssetId=HA102753275&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753276&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102780999&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102781000&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753279&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753280&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753280&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753277&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753278&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753281&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753282&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753283&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753284&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753285&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA103980604
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35. ISOWEEKNUM 

function 

Date and time:    Returns the number of the ISO week number 

of the year for a given date 

36. MUNIT function Math and trigonometry:    Returns the unit matrix or the 

specified dimension 

37. NUMBERVALUE 

function 

Text:    Converts text to number in a locale-independent manner 

38. PDURATION function Financial:    Returns the number of periods required by an 

investment to reach a specified value 

39. PERMUTATIONA 

function 

Statistical:    Returns the number of permutations for a given 

number of objects (with repetitions) that can be selected from 

the total objects 

40. PHI function Statistical:    Returns the value of the density function for a 

standard normal distribution 

41. RRI function Financial:    Returns an equivalent interest rate for the growth of 

an investment 

42. SEC function Math and trigonometry:    Returns the secant of an angle 

43. SECH function Math and trigonometry:    Returns the hyperbolic secant of an 

angle 

44. SHEET function Information:    Returns the sheet number of the referenced 

sheet 

45. SHEETS function Information:    Returns the number of sheets in a reference 

46. SKEW.P function Statistical:    Returns the skewness of a distribution based on a 

population: a characterization of the degree of asymmetry of a 

distribution around its mean 

47. UNICHAR function Text:    Returns the Unicode character that is references by the 

given numeric value 

48. UNICODE function Text:    Returns the number (code point) that corresponds to the 

first character of the text 

49. WEBSERVICE function Web:    Returns data from a web service. 

50. XOR function Logical:    Returns a logical exclusive OR of all arguments 
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